Version of 16. April 2010

Scratchpad Training Course - Basic
This one-day course is intended to help current and prospective Scratchpad owners develop their site building skills. You will be given the opportunity to learn best practice and gain a better understanding of what the Scratchpads can do for you and your research community. The focus of the basic course lies on adding various kinds of data, on generating taxon pages and on communication with other users. Our goal is to provide a taste of what the sites can do, and allow you to independently explore the site after the event. We also offer an advanced course concentrating on the import of data, creating of custom content types and views, and managing of groups.

The basic course will cover:

2Basics


2Basic features


3Administration


5Add data


5Taxonomy (T)


6Literature (T)


7Locations and specimens (T)


9Image gallery and images (T, C)


9[Character projects (T)]


10[Other content types (T, C)]


11Manage data


11Taxon pages (Widgets) (T)


12Find data


12Search


12Communicate


12Forums (C)


13Newsletter (C)


14Help and support




If your goal is to establish a taxon based website you should focus on the parts marked with a "T", if your goal is to establish a community/society based website without a classification, you should focus on the parts marked with a "C".

You can skip parts of the course you already know about, however, be aware that some parts build on each other. For example to do the taxon based chapters you need to import a classification first (Taxonomy 1-5).

Twenty training sites have been established at:

http://training[1-20].myspecies.info
You will be issued with a number that corresponds to your training site and should log in with the following credentials:

Username: username

Password: password
For a shortened version of this course concentrate on: basic features, administration (1-5), taxonomy (1-5), literature (7), images (3-5), and taxon pages.
Basics

Basic features
Log in, the "taskguide", getting help, and your "first page"
1. Open a web browser (preferably FireFox), and go to the URL of your training site.

2. Log in to your site with the username and password given overleaf.
3. Once logged in, accept the terms and conditions and you will be taken to your user profile. You will be able to edit your credentials at a later point.
Note that the view has changed. What you see as a logged-in user is different to the view site visitors receive.

4. Click the Scratchpad training logo in the upper left corner to get through to the front page of your site. You will see the Scratchpad taskguide on the first page. This guide provides a simplified overview of selected Scratchpad features. As we add new features to the Scratchpad, your taskguide is updated, and is always available from the URL http://YourSite/taskguide/. However, you can remove it from the front page at any time and it is only visible to users that have logged in.

5. Help associated with each task can be found in a series of FAQ and screencasts at http://scratchpads.eu/help.
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Take a look at the "Content" menu on the left side of your site. This provides the various options for creating and accessing content in your site. Note the Roll over icons over each option. Click on the "Add a Page Node" icon which appears when you hover over the "Page" link. 
7. Enter a "Title" and some "Body" text for your page and click the "Save" button. You have just created your first page.

8. Edit content on the page by clicking the 'Edit' tab. The 'Body' section has a rich text editor. Explore some of the features of the rich text editor by modifying the format of the text you have entered. For your reference, the module that enables rich text editing in the Scratchpads is called 'TinyMCE' (pronounced 'Tiny mice').
You need to be aware that if you copy text into the rich text editor it will retain all the formating of this text especially line breaks even though you might not immediately see this in the rich text editor. To avoid this, click on the 'Paste as Plain
Text' icon and copy the text into the pop up field. Make sure that the 'Keep linebreaks' check box is empty and click on ' Insert'. Alternatively, you can paste text into the rich text editor and remove unwanted formating in the html version (see below).

9. Click the link to 'Disable rich-text' below the body field.
10. You will see the HTML representation of the text you have entered.
11. Note the publishing options available under 'Show Advanced Options' toward the bottom of the page. These options are available to most types of content published in a Scratchpad. Explore them a little, and ask a demonstrator about them if you have time. 
12. Click the "Save" button once you have completed the page. Note that this option will change to "Next" once a taxonomy has been added to the site (more on this later).

13. Click the "Page" link in the content menu to find the page you just made. Click on the link (in the title) to the page you just made.

14.  Explore the Clone settings – try making another page using the clone option.
Administration
Site information, blocks, menus, users & roles
1. Click the "Administer" link in the Navigation menu, which is the menu under your user name. You will see two options in the menu. A basic "Administer" page and an "Advanced" administration page. Only site maintainers can see and access the "Advanced" administration page. Explore the following administration areas and feel free to change the settings and make changes. 
The following assume you are viewing the basic "Administer" page.

2. List content: From here you can access all the content or "Nodes" that have been created on your site. You can filter by a particular content type, and also perform updates on selected nodes.
3. Blocks: From here you can add and change the position of various blocks to the sidebars of your site. We recommend keeping the sidebars of your site relatively uncluttered, and also perhaps not using the right sidebar. Try moving the search block to the right sidebar.
4. Menus: Try changing the menu options around and adding a new menu. The menu will only become visible when you add menu items to it and activate the block by e.g. moving it from the 'Disabled' section to the left sidebar on the blocks page.
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The following assume you are viewing the "Advanced" administration page.

5. Site information: This allows you to change the site's: Title (Name), Email address associated with the site, Slogan, Mission statement, Footer message, and front page settings. If you prefer a static front page, instead of the default 'news' front page, you can change this from here. Change the default front page to your liking.
6. Themes: This allows you to change how your whole site looks. From the list choose the theme you like and mark the ‘Enabled’ checkbox. Click on ‘Save configuration’. If you also select the ‘Default’ button the theme will change immediately. Click on ‘configure’ next to your chosen theme. For some of the themes, like Garland, you can choose your preferred ‘Color scheme’. Change the ‘Custom’ color set by clicking for example on ‘Base color’ and clicking on a color in the outer circle and than fine tuning the color by clicking in the inner square. The preview will change, so that you can see what is meant by ‘Base color’ and how your choices will look together before you save. Under the 'Global settings' for all themes you can select your ‘Toggle display’ and upload a logo image and if you like a shortcut icon. Click on ‘Save configuration’. Be sure you renew your screen (e.g. by clicking Ctrl+F5) to actually see the changes you made. 

7. User management: The "Users" page allows you to list all the users of your site, and perform actions (upgrade, delete, edit) on them. You can also create a new user, which you can do now. Click "Add user" at the top, and fill out all the relevant boxes with your own information. Note that training sites will come up with an error message on map related content. Just ignore this by clicking OK. This message is because the Google Map API is not specified on training sites. You can assign yourself to one of three roles and subsequently log in with this account:
a. Contributor: Able to create content and edit own content.
b. Editor: Able to create and edit own content, and also edit other people’s content.
c. Maintainer: Like editor, but also has administration privileges.
8. My Account: Click on your username to view your account. From here you can do a number of things that may make the use of a Scratchpad a more pleasurable experience. You can see all the content you have recently created under "Track" – this is similar to the "Content" menu under administration, but filtered just for you. If you click the "Edit" tab, you can edit the information associated with your account, including your name and location, and you can even specify your location using a Google map (try clicking on the map) though this map is currently not showing in the "View" mode. For people that use OpenID log-in, they can add their OpenID identity. This enables them to log into more than one site with a single "OpenID" identity. 
9. Feel free to ask about any of the other configuration options.

Add data

Taxonomy (T)
Importing, displaying and using classifications
1. Within the basic Administration page, click "Add" under the taxonomy section to create a new taxonomy.

Note that taxonomies do not just have to be biological taxonomies. Country lists, imaging techniques, keywords etc, can all be treated as "taxonomies" in the context of your site. We are going to explore two different methods of importing a classification of Primates into your site.

2. Minimally enter the vocabulary name (Primates) in the Vocabulary Name field; you can also add a description of the taxonomy in the Description field if you wish. Under the content types pull down menu, note that you can choose which types of content to associate your taxonomy with. By default, all content types are checked. Click "Save".
Having created a vocabulary you now need to add the list of terms (names).

3. Click the "Import classification" tab to reveal the options for importing a classification. If you have more than one vocabulary, you need to select the new vocabulary you just created (Primates) under the "Destination Classification" pull down menu. Note that you will not need to select a taxonomy if there is only one (e.g. the Primates one that you have just added).

4. Click the "Import from EOL" link and enter "Primates" in the text field. 

5. Click search. The name "Primates" appears in several possible classifications. Choose the first one, and click "Import".

This will import the complete classification of the taxon you type, into the Scratchpad. You can choose from any of the available classifications, and any taxonomic group that you know to be within these classifications. We recommend that you restrict your choice to groups that contain less than 50,000 taxa.

6. When the import is complete, click the "List" tab and select "Edit Classification". Explore the taxonomy editor and all of its functions.
We will now try another way of importing a classification. (If you want, you can skip 7 & 8  and continue with 9)
7. Go to http://scratchpads.eu/scratchpad-training-files and download the "Hominidae.txt" spreadsheet.

8. Open the tab-delimited file in Excel. You will see a Child-Parent way of depicting the classification.  Close the file without saving. Then repeat steps 1-4 above using a new classification name (e.g. "Hominidae"), but instead of choosing "Import from EOL" in step 4, choose "Import from Text File" and upload the file. 

Note that once a classification has imported it will appear in the top left sidebar of your site. This is created automatically when you import a classification. To move or delete this, go into the "blocks" section of your site (under Administration in the layout section) and you will see a block labeled "TinyTax Block for …" where … represents the name of the classification. 
9. You can configure the TinyTax block for "Hominidae" to show the classification resolved to the order "Primates" by default. Do this by clicking "configure" next to the TinyTax block and entering the term "Primates" in the "Term" box under the configuration options for this block (You might have several Primates terms and have to try out which is the correct one). Explore the other settings and click the "Save Block" button. Also from the blocks page try re-ordering the block by dragging the cross icon next to the name of each block.

Literature (T)
Import, edit and add bibliographic references
1. Firstly we will import a bibliography that has been exported from Endnote (Exporting from Endnote X is as simple as selecting "Export" from the "File" menu, and saving the Library in XML format). 
2. Download the "Primates.xml" file from the example data (see http://scratchpads.eu/scratchpad-training-files), which is in Endnote 8+ XML format

3. Click the "Import a Bibliography from your reference manager" icon appearing next to "Biblio" in the "Content" menu. This will bring up a form with a number of options. Select the XML file you just downloaded; select Endnote 8+ XML from the pull down menu; then click "Import". Wait while the records are imported.

4. Click "Biblio" in the Content menu and you should see all your imported records.

5. We will now edit one of these entries. Click on the title of any entry, which will take you to the node page for that entry, next click on the "Edit" tab. (Note that clicking an author will do a search of bibliographic content for that author).

6. You can now edit this individual entry, changing any of the fields that you consider to need changing. Once you have made you changes press the "Save" button. 
7. Finally we will create a new bibliography entry. Click on the "Add a Biblio node" icon in the Content menu, which should give you a page allowing you to select the publication type. Select "Journal Article" (or anything else if you’re confident), and fill out the fields given (do not worry about the initial warning message when selecting "Journal Article"). Remember to select terms in your taxonomies or add taxon names to the Keywords section if you want this reference to be visible to your widgets (on your taxon pages).

8. You can also add a bibliographic record from the "DOI" number of the publication, or by cutting and pasting the "BibTex" record.
Personal bibliographies (for your own publications) and auto-tagging on import are additional options available for the bibliography module. 
Locations and specimens (T)
Add a location and add, clone and import specimens
1. Click on the "Add a Location (D.w.C. 1.2.1) node" icon under the "Content" menu. Enter a locality name, and on the Google Map, click the position of your specimen (anywhere will do). The latitude and longitude will automatically appear in the appropriate fields.

2. Select a country.
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Click on the "Extra Fields" link. Additional but rarely used optional fields are present within this section. These conform to the Darwin Core (version 1.2.1 format) recommended by TDWG (the Taxonomic Databases working group) and GBIF. Make sure you give the location a title in the title field, then click save. This creates your location record.

4. Click on the "Add a Specimen (D.w.C. 1.2.1) node" icon under the "Content" menu. Once the page loads you will be confronted by five different tabs: Required, Taxonomy, Collection, Miscellaneous, and Location. Each of these tabs has different fields that can optionally be completed in order to create a new specimen record. Only the "Required" tab contains compulsory fields, which are marked with an asterisk (*). These are deliberately kept to the bare minimum.

5. We will start by creating a fictitious specimen, so no need to worry about getting the required information correct. Fill out the fields under the Required tab.

6. The "Taxonomy" tab contains the basic information about the identification of your specimen. The important field here is the second one "Taxonomic name" which is linked directly to all your sites taxonomies. Simply start typing the taxon name of a specimen, and assuming that you have imported a classification with this taxon name in it, your Scratchpad will autocomplete the field. A number of fields offer similar functionality to this, e.g., the "Institution code" and "Collection code" fields.

7. Fill in some more information on the "Collection" and "Miscellaneous" tab, this can be as little or as much as you like.

8. Finally, under the "Location" tab, select the location you created in steps 1-3. It is worth noting that the same options as with a basic "Page" are open to you here. You can have the specimen published to the front page, and link to it from a menu. Now press the "Save" button.

9. You should now be taken to a page where you can view your specimen.

This specimen can now be linked to from an image, or can be cloned (see below) to make creating further similar specimens easier.

1. You can clone any content type you like, although here we’re outlining how to clone a "Specimen" record.

2. Ensure you are viewing the "Specimen" that you have just created. You will see at the top a number of menu options, one of which is "Clone" – click this.

3. This will bring up a page with all the form elements filled out so that if you were to press submit now, you would create a second "Specimen" record identical to the first.

4. Change a couple of fields and press submit, you’ve now created a second "Specimen" record in a short space of time.

In practice most people will (at least initially) want to enter specimen records in bulk. This can be done from a comma or tab separated file created within an Excel spreadsheet.

1. In Excel, try creating a dummy set of specimen records. You can also copy the headers and/or records from the template file 'SpecimenImportTemplate.txt' at http://scratchpads.eu/scratchpad-training-files. The header row should contain the titles of the required fields for a specimen record. To check which fields are required click on the "Add a Specimen (D.w.C. 1.2.1) node" icon under the "Content" menu and find the fields marked with a red asterisk. In addition to these fields you need to add the "Taxonomic name". You may also choose to add additional data as you see fit. It will make the import easier if you use the correct field names in the header. Subsequent rows should contain the dummy specimen records. Make sure that for the fields which appear as drop down menus when you add a specimen, you enter one of these options in your matrix because the import will not work with terms that are not in this list. The same holds for the "Taxonomic name": you need to enter a term that is in your vocabulary. Under 'Location node' you need to enter the title of the location you want to link with the specimen. 
2. Export the data file as a "CSV (comma delimited)" file (csv format) from Excel. Export as "Text (tab delimited)" (txt format) is also possible, but will add quotationmarks around text containing commas, which need to be deleted in Word.
3. Click the "Import from CSV file" icon under specimen in the "Content" menu.
4. Upload your file and click "Next".

5. Follow the instructions that appear on screen, uploading the file, choosing "Comma separated" (or tab separated) values, matching the column headings and parsing the data into the Scratchpad database. This is a very quick way to bulk import records.
Image gallery and images (T, C)
Create an image galleries and add and annotate images 
1. First we need to create an image gallery into which we will import the pictures. Click on the "Add a Image node" icon in the Content menu and then click on "Add a new image Gallery" below the Image gallery drop down box.
2. Give the gallery a name and description. Under the 'Advanced options' you can choose a parent image gallery or "weight" the gallery to determine its position relative to other image galleries – the default gallery is simply called "Library". When complete, click "Save".
3. Click "Add Image node" in the Content menu again. You are presented with an option to upload single or multiple images. Try the single image option first.

4. Choose the image gallery you just created and select a taxon name relevant to your image in the classification box.

5. Follow the instructions on screen, using one of the example images provided at http://scratchpads.eu/scratchpad-training-files. Complete the appropriate fields relevant to your image, and click "Save".
6. Click on the image link in the Content menu. You will see your image in your new gallery. Try clicking into the gallery, clicking on the image, and editing the annotations associated with the image. 
7. Next try uploading multiple images. Click on the "Upload multiple images" icon next to the "Image" link in the Content menu. Click the square "Add" button, select the example images on your computer, and click in "Upload". These images will need to be (for the moment) annotated individually through the image gallery or through the "Recent posts" link in the user menu. An updated version of the Scratchpads will allow you to annotate the image metadata in our new matrix editor. Head back to the image gallery to see your newly uploaded pictures. 
[Character projects (T)]
Build a character matrix 
Our data matrix editor is a work in progress. This currently allows you to build a database of characters suitable for phylogenetic analysis, identification keys or tables of numeric or textural descriptions. Subsequent versions of this editor will support editing of current content types in a spreadsheet like environment. 

1. Click on the "Add a Character Project node" icon in the Content menu. Give your project a title and a brief description.

2. Under "Vocabulary", browse the Primate classification and choose the taxa you would like to include in your project. Click "Save".

3. Add some characters by clicking the "Add Character" button on the right hand side of the matrix. Try a mix of restricted characters, numeric characters and text characters.

4. Try "Scoring" the characters in the data editor, just like you would if you were editing data in an Excel spreadsheet.

5. Try dragging and dropping the characters in the editor. Note the impact on the character groups.

Subsequent work on the editor will support the export of data in various formats suitable for phylogenetic analysis, key construction and character lists and datasets formatted for publication.
[Other content types (T, C)]
On your own, explore the other content types

1. Countries map (T)
2. Phylogenetic tree (T) (copy the text of MammalPhylogeny.txt (http://scratchpads.eu/scratchpad-training-files) into the 'Nexus or Newick data' field.
3. Blog (C)
Try to create example content under each of these content types and get this to appear on the appropriate taxon page. If you need help, ask one of the demonstrators or explore the help section of the Scratchpads.eu website.

Manage data

Taxon pages (Widgets) (T)
Aggregating internal and external data on one page
1. Try browsing the Hominidae classification you previously uploaded into your site, from the block you created when you imported the Hominidae classification in the left hand sidebar. Navigate by clicking on the taxon name. Note that content is cached, and sometimes the servers where this information comes from time out. Try reloading content (especially in Safari) a few times.

2. Browse to the "Hominidae". Information is displayed in a series of "Widgets" – we sometimes refer to these as "panels" "windows" or "panes".
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Click the "padlock" icon at the top of the page. Try dragging the widgets around to get the arrangement you like. Also try closing some of the unused widgets (with no content) by clicking the red cross associated with those widgets.
4. When you have the arrangement you like, click the padlock icon again. You can choose to apply this arrangement to all taxon pages, or restrict this just to the page you just made.
5. Next try clicking "sort" within one of the widgets (e.g. Flickr). Try "accepting" images you want to preserve in the list, and clicking the "cross" icon on images you don’t want to see in your results list. You can also set the number to display (this will set the number for this widget on all taxon pages, not just the one you are viewing currently (April 2010), but we hope to fix this soon).  Click "Close" when you are done. Renew your webpage to view the changes.

6. Try increasing or decreasing the size of a panel using the arrow keys in the top right corner of each panel. Try clicking around the other taxa to curate and customize your pages.
We have developed selected Widgets that pull information from other sites (currently GBIF, Flickr Images, Yahoo! Images, NCBI, Wikipedia, Google Scholar, Morphbank and the Biodiversity Heritage Library). More can be easily added if the services of the data provider are appropriate for us to use.
7. When looking at a taxon page, using the Content menu try creating a new "page" as you did in the first exercise by clicking the "Add a page node" icon. Once you have clicked "next" note that the taxon name of the page you were looking at appears in the "terms to use" section. 
8. Click "save" and you will go back to the original page your were on. A widget will appear with the text you have created.

The same applies to the other content types present within the site. If you add them from a taxon page they will contextually appear back in the relevant taxon page.
When you first set up your site there will be a lot of widgets showing which you don't need. Close all unnecessary widgets as they will only confuse users of your website.
Find data

Search

Advanced search
There are several ways to find specific content on a Scratchpad. One way is to use the Search box in the left sidebar, which has three different search options: simple, taxonomy, and advanced. 

1. The default is the simple search. Enter a word from one of the pages you created in the search field and click on ‘Go!'. You will get a list of all the content on the Scratchpad which contains your search term.
2. If you want to find a specific taxon page or content tagged with a specific term in one of your taxonomies, you can use the taxonomy search. Click on ‘Taxonomy’ above the search field and start entering a term used in your classification, e.g. "Homo". As you type, terms will (slowly) be listed underneath the field and you can choose the correct one. If no terms appear your word is not part of the taxonomy. Click on ‘Go!’. You will usually get a taxon page. If not you will get a list of all the nodes which are tagged with this term. 

If your classification is set up to allow taxon pages, you should view a taxon page (widgets) as result of a taxonomy search. However, if your term is part of several vocabularies, e.g. the biological classification and the keywords, then the system gets confused and shows just a list of content. If this is the case you will have to find the taxon page via navigation of the tree in the classification block.
3. Advanced search: Click the ‘Go!' button without entering anything in the search box. Click on ‘Advanced search’ to extend further options. Enter your search term and choose the category or type of data you want to search, e.g. check ‘biblio’ if you only want to search for bibliographic citations. 

Further options to find content on a Scratchpad are through the Content menu as explained in the 'Basic features' chapter, through the 'List' Content/Data in the basic administration page, through the 'Track' option under 'My Account' in the Navigation menu, and through 'Recent posts' in the Navigation menu. When using the first two options, the content is or can be sorted by content type. When using the last two options the content is only sorted by date of last editing. 
Communicate
Forums (C)

Create a forum and forum topics
1. Go to the advanced administration page by clicking on 'Administration' and then the 'Advanced' link in the user menu and click on 'Forums' in the content management section. 

2. To add a new forum click on 'Add Forum', enter the name of the forum a description and a parent term if you want a hierarchy of forums. Save. 
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See the help text on the forum administration pages for more information. 

4. To add a new forum topic go to the ‘Content’ menu and hover with the mouse over ‘Forum topic’ and click on the 'Add a forum topic node' icon which appears to the right. Enter the Subject, choose the forum in which you want to submit your topic and enter the text of the topic in the ‘Body’ field. 

5. Depending on the Scratchpad settings you will also be able to choose a taxonomy term. Save. 

6. To reply to a forum topic click on the ‘reply’ link. Enter a subject and your comment. 

7. Click on ‘Preview comment’, edit the text if necessary and click on ‘Post comment’. 

8. You can access the forum if you click on ‘Forum topic’ in the ‘Content’ menu. 
Newsletter (C)

Create a newsletter
1. Go to the advanced administration page ('Administer' > 'Advanced') and click on 'Newsletters' and again on 'Newsletters'. 

2. To add a new newsletter click on 'Add newsletter', enter the requested data and save. Users will be able to subscribe to the newsletters when they register or later via 'My account' under the newsletter section. Subscriptions can be managed via the advanced administration page.
3. To add a new newsletter issue go to the ‘Content’ menu, hover with the mouse over ‘Newsletter issue' and click on the 'Add a newsletter issue node' icon which appears to the right. Create your issue, pick your settings and save.
Help and support

Help and tips for working with Scratchpads can be found in a series of FAQs at http://scratchpads.eu/faqs and screencasts at http://scratchpads.eu/screencasts. The screencasts have not yet been updated to the current Drupal 6 version of the Scratchpads and will deviate from what you can actually see and do in some cases.

For feature requests and bugs please use the feedback button which appears on the right hand side when you are logged in. If you have specific questions or would like advice or help in how to best set up your site, please email Irina Brake at i.brake@nhm.ac.uk. Don't be afraid to ask 'stupid' questions and don't get hung up on a problem for hours. In some cases the solution might be easy (you just have to know it…) in others it might be a bug only our programmer can solve.

To get ideas you can also check what other people have done with their sites and how they have customized them: Browse the list of the current Scratchpads at http://Scratchpads.eu/sites. To find examples for certain features check out http://scratchpads.eu/live-examples-scratchpad-features. 

Vince Smith, Irina Brake, Simon Rycroft & Dave Roberts

16 April 2010
To help us improve this course please fill out the feedback form on the next page.

Feedback form – Basic course
Name _____________________________

Date ________________________

Grading: 1=Poor, 2=Satisfactory, 3=Good, 4=Very Good, 5=Excellent

1) To what extent did the course meet its outcomes:

· Gain a better understanding of what the Scratchpads can do for you




1       2       3       4       5
· Know how to first set up a Scratchpad







1       2       3       4       5

· Know how to navigate a site









1       2       3       4       5

· Know how to add various kinds of data







1       2       3       4       5

· Know how to generate taxon pages








1       2       3       4       5
2) To help us improve the manual please tell us which of the chapters you completed during the course and which need improvement using an "x" or checkmark.

	
	fully completed
	partly completed
	not done
	chapter needs improvement

	Basic features
	
	
	
	

	Administration
	
	
	
	

	Taxonomy
	
	
	
	

	Literature
	
	
	
	

	Locations & specimens
	
	
	
	

	Image gallery & images
	
	
	
	

	Character projects
	
	
	
	

	Countries map
	
	
	
	

	Phylogenetic Tree
	
	
	
	

	Blog
	
	
	
	

	Taxon pages
	
	
	
	

	Forums
	
	
	
	

	Newsletter
	
	
	
	


3) Were there areas you would have liked more information on?

Yes/No
If yes, please detail: ……………………………………………………………………………..

Were there areas in which you felt you spent too long: 


Yes/No
If yes, please detail: ……………………………………………………………………………..

4) Your trainer
How easy was your trainer to understand?



1       2       3       4       5
How helpful and approachable was your trainer


1       2       3       4       5
Please rate your overall impression of the trainer's presentation
1       2       3       4       5

Any other comments about your trainer………………………………………………………

…………………………………………………………………………………………………

5) Do you have any recommendations on how to improve the course?

………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………

6) Overall Grade
Please grade your training experience overall by circling one of the following:

Poor

Satisfactory

Good

Very Good

Excellent

Any other comments:…………………………………………………………………………..

………………………………………………………………………………………………….

Thank you for taking time to give us your feedback. Please return this form to your trainer.
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